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 Introduction to RealPlayer Plus
Welcome to RealPlayerÔ Plus 5.0 by RealNetworks. RealPlayer Plus gives you quality "one-button" access to the 
news and entertainment that you want.

Using RealPlayer Plus, you can listen and view thousands of hours of live and pre-recorded clips, including 
sporting events, live radio stations, news, music, and lectures. RealPlayer Plus allows you to quickly and easily 
preset your favorite channels, scan for new stations, and enhance your control by getting better audio and 
video quality.

Visit RealNetworks' website for updated information at http://www.real.com.
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 RealPlayer Components
In addition to RealPlayer Plus, several different special-purpose RealPlayer components are installed on your 
computer. The components work with different elements within World Wide Web pages to deliver sound and 
video in a variety of ways. The RealPlayer Plus components are:

RealPlayer Plug-in The Plug-in provides access to RealMedia programming 
and extends the audio and video capabilities of your 
Netscape browser (Netscape Navigator 2.0 or later). 

RealPlayer Control for 
ActiveX

The RealPlayer Control for ActiveX provides access to 
RealMedia programming and extends the audio and 
video capabilities of your Internet Explorer browser and 
Visual Basic applications.

RealAudio Xtra for 
Shockwave 

The RealAudio Xtra for Shockwave provides RealAudio 
programming within a Macromedia Shockwave movie.

PlusZone
The PlusZone (http://pluszone.real.com/) is a one-stop, centralized Web site for product information, online 
offers, and premium content, the PlusZone lets Plus customers learn about the product and find out about cool 
offers.

PlusZone also provides links to RealMedia sites such as the Daily Briefing, Timecast, WebActive, and 
LiveConcerts.



 Overview of RealPlayer Plus
RealPlayer Plus enables you to experience RealMedia files over the Internet or over a local area network in real 
time, without downloading the clip to your hard drive. When you click a RealMedia link from a World Wide Web 
page, your RealPlayer Plus automatically opens and plays the file you have selected.

This section gives you a tour of the different controls and features of RealPlayer Plus.

Overview of RealPlayer Plus

Section Description
Play/Pause Button

Click the  to play or pause a clip, depending 
on the status of the clip. 

Record Button
Click the  button to record the clip currently being 
played.

Stop Button
Click the  button to stop the clip. 

Position Slider The slider moves as a clip is being played. You can fast 
forward or rewind to a different section of the audio clip 
by dragging the slider.

Fast Forward/Rewind Buttons
Click either the  button or the  button to fast 
forward or rewind the clip in 10-second intervals.



Link to the RealNetworks 
Home Page If you are connected to the Internet, click the  

button to link to the RealNetworks Home Page. 

Image Window If you are playing a video clip, the image appears in this 
window.

Preset Buttons You can set these buttons to automatically link to a 
specific site and play a RealAudio or RealVideo clip. The 
URL location and the label of the Preset buttons are 
customized on the Preset tab of the Preferences window. 
Or you can set a button to the current clip by clicking 
with the right mouse button and selecting Set Preset to
(current clip).

Scan Button The  button allows you to scan clips, similar to 
scanning stations on your car radio. 

Destination Buttons These buttons can be set to various RealMedia content 
throughout the Internet. Click one of the buttons to 
access the customization page where you can set these 
buttons to compelling content. 

Title, Author and Copyright 
Text

The content provider specifies the text in these fields; 
they normally describe the clip being played.

Volume Control The volume control indicates the volume at which the 
clip is being played. Increase the volume by dragging the
control up, and decrease the volume by dragging the 
control down.

Mute Button
Click the  button to silence the audio portion of 
the clip. The clip continues to play. Click this button 
again to hear the audio portion of the clip.

Status Bar The status bar displays information about the player and 
the clip, including: 

Indicates the clip currently being played is stereo.

Indicates the clip currently being played is mono.

Green lightning bolt indicates some loss of playback 
quality due to quality of connection.

Red lightning bolt indicates poor playback quality due to 
quality of connection.

Indicates that the RealPlayer is buffering the stream.

Indicates that the network is busy and the player is 
buffering more data.

Indicates that the RealPlayer is recording the current file.

Indicates that the current file is not recordable. 

00:00.0/00:00.0 The elapsed time (the length of time that the clip has 
been playing) and the total time (the length of the entire
clip).

Note: When playing a live stream, Total Time value is 
replaced by the word live.

Status The current status of the Player. For example: 
Buffering, Playing 28.8 Network Stream, Stopped, or



Paused.

Zoom Button
Click the  button to open a menu where you can 
choose to double the video image area, enlarge the 
image area to full screen (Windows 95 or NT only), or 
return the image area to normal size.

Compact Button
Click the  button to display a subset of the buttons. 
Click the Enlarge button to display all of the controls.

See Also:
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RealPlayer Plus Menus
The RealPlayer Plus has five menus: File, View, Clip, Sites, and Help. These menus allow you to take full 
advantage of RealPlayer Plus features.

See Also:

File Menu 
View Menu 
Clip Menu 
Sites Menu 
Help Menu 



File Menu
Commands from the File menu allow you to play RealMedia files without using your World Wide Web browser to 
find files on the Internet, to enable PerfectPlay mode, and to exit RealPlayer Plus. 

Menu Option Description
Open Location Select this option to play RealMedia files through the 

Internet without using your World Wide Web browser. In
the Open Location dialog, enter the URL (Internet 
address) of a .rm, .ra, .ram, or .swf file.

Open File Select this option to play a local RealAudio or RealVideo
file. When the Open File dialog appears, select 
a .rm, .ra, .ram, or .swf file stored on your computer.

Open Recent Select this option to view a list of recently played clips. 
You can select a clip from this list to hear or view the 
clip again. 

PerfectPlay Mode Select this option to switch to PerfectPlay mode; a 
check mark appears next to the option. This mode 
enables you to improve the quality by increasing the 
amount of the clip that is buffered. The time it takes to 
buffer the clip will be slightly longer, but playback 
quality, especially with 14.4 and 28.8 Kbps modems, 
should be improved. To return to Regular mode, select 
this option again; the check mark is removed.

Note: You cannot use PerfectPlay mode with a live 
stream.

Exit Select this option to exit RealPlayer Plus.

View Menu
Commands from the View menu allow you to control the appearance, to customize the operation, and view the 
performance of RealPlayer Plus.

Menu Option Description
Normal Select this option to display all buttons and controls; a 

mark appears next to the option. 

Compact Select this option to display only the image area (if 
playing a RealVideo clip), a subset of the buttons and a 
reduced Status bar.

Auto-Size Select this option to display only the image area (if 
playing a RealVideo clip) when the cursor is not over 
the RealPlayer Plus window; a mark appears next to the
option. When the cursor is on the window, the Compact
controls are displayed.

Presets & Scan Select this option to display the Preset and Scan button
bar on RealPlayer Plus; a check mark appears next to 
the option. Select the option again to hide the button 
bar; the check mark is removed.

Destinations Select this option to display the Destinations; a check 
mark appears next to the option. Select the option 
again to hide the bar; the check mark is removed.

Info & Volume Select this option to display the volume control, and the
title, author, and copyright information for the clip; a 
check mark appears next to the option. Select the 



option again to hide the information; the check mark is 
removed. 

Status Bar Select this option to display the Status Bar; a check 
mark appears next to the option. Select the option 
again to hide the bar; the check mark is removed. 

Preferences Select this option to display the Preferences window for
configuring RealPlayer Plus. You can set preferences 
from this window. Refer to Setting Preferences for more 
information.

Statistics Select this option to display transmission quality 
information in the Connection Statistics dialog. The 
Connection Statistics window reports the performance 
of the Internet connection between the Server and 
RealPlayer Plus.

Always on Top Select this option to make RealPlayer Plus remain on 
top of all other windows, even when another window is 
active; a check mark appears next to the option. 
Always on Top is convenient for keeping RealPlayer Plus
visible while you interact with your World Wide Web 
browser. Select this option again to allow other 
windows to open on top of RealPlayer Plus; the check 
mark is removed.

Clip Menu
Some RealMedia files can include several clips played one after the other. Commands from the Clip menu allow 
you to move between clips in a multi-clip RealMedia (.ram) file and when scanning. This scanning is similar to 
using seek buttons on a CD player. If there is only one clip at the link you are accessing, these options are not 
available.

Previous Clip and Next Clip are also available from the shortcut menu that appears when you right-click the 
mouse button in RealPlayer Plus window.

Menu Option Description
Previous Clip Select this option to play the previous clip in a multi-

clip (.ram) file or when scanning.

Next Clip Select this option to play the next clip in a multi-clip 
(.ram) file or when scanning.

Sites Menu
Commands from the Site menu allow you to access various World Wide Web sites. This feature works with 
popular World Wide Web browsers. If you are connected to the Internet, and your World Wide Web browser is not
open, RealPlayer Plus opens it for you.

Note: You must be connected to the Internet in order to reach these sites.

Menu Option Description
PlusZone Select this option to access PlusZone. This site is 

offered exclusively to RealPlayer Plus owners.

Real Home Page Select this option to access the RealNetworks' Home 
Page.

Real Content Select these options to access sites that feature 



RealMedia.

Timecast: Your RealMedia 
Guide

Timecast contains a list of World Wide Web sites 
providing RealMedia content.

MusicNet MusicNet contains a directory of RealMedia happenings 
in the music world.

LiveConcerts.com LiveConcerts.com is the premiere site for live music 
events broadcast on the Internet using RealMedia.

Film.com Film.com provides an unprecedented collection of 
material on film for a world-wide audience, offering 
breadth and depth, and bringing together critics, 
writers and movie buffs everywhere.

Customize RealPlayer Plus Select these options to customize your RealPlayer Plus 
content buttons.

Customize Daily Briefing Build a custom newscast with stories from well-known 
news and entertainment organizations. You can access 
your personalized PlusZone page by clicking the Daily 
Briefing button on the RealPlayer Plus. 

Customize Destinations Select this option to access a page where you can 
customize your destination buttons.

Customize Presets Select this option to access a page where you can 
customize your preset buttons.

See also:
Setting Your Destination Buttons 



Help Menu
Commands from the Help menu provide online help and information about RealPlayer Plus.

The latest support and technical information is available at: 

http://service.real.com

Please refer to the enclosed Technical Support Card for more information on contacting RealNetworks Technical 
Support.

Menu Option Description
Contents Select this option to open the online help for RealPlayer.

Online Tutorial Select this option to access the RealPlayer Plus tutorial 
which describes the major features of the Player.

Common Questions Select this option to access the RealNetworks 
Frequently Asked Questions page. You must be 
connected to the Internet for this option to work.

Search Knowledge Base Select this option to access the RealNetworks 
knowledge base and search for the answer to a 
question. You must be connected to the Internet for this
option to work.

Service & Support Select this option to access the main RealNetworks 
Technical Support and Service Page. You must be 
connected to the Internet for this option to work.

Full Screen Help Select this option to access RealNetworks' Full Screen 
and Direct Draw information page.

Suggestion Box Select this option to access Progressive Network's 
Comments and Suggestions page. Here you can send 
any comments directly to RealNetworks.

Check for Upgrade Select this option to query the RealNetworks home 
page for upgrade information. A dialog box appears 
telling you if there is an upgrade available.

About Select this option to display RealPlayer Plus version and
Copyright information.



Using RealPlayer Plus
The RealPlayer Plus enables you to click a RealMedia link from your Web browser and begin playing clips 
instantly, without download delays. In addition, you can pause, rewind, fast-forward, stop, and start the clip at a 
click of a button.

See Also:

Starting a Clip 
Pausing a Clip 
Stopping a Clip 
Muting a Clip 
Recording a Clip 
Changing the Size of the RealPlayer Plus Window 
Changing the Size of the Image Area 
Playing Clips in PerfectPlay Mode 
Selecting a Preset Button 
Setting a Preset Button 
Setting Your Destination Buttons 
Scanning Clips 



Starting a Clip
There are several ways to start playing a RealAudio or RealVideo clip:

· Click a RealMedia link on a World Wide Web page. Your World Wide Web browser opens RealPlayer Plus 
and the clip is streamed to RealPlayer Plus immediately. After storing a few seconds of the clip 
(buffering), the playback begins.

· Access a World Wide Web site or select an action that automatically plays a clip. Your World Wide Web 
browser opens RealPlayer Plus and the clip is streamed to RealPlayer Plus immediately. After storing a few
seconds of the clip (buffering), the playback begins.

· Click one of the Preset buttons or the Scan button on RealPlayer Plus. The clip is streamed to RealPlayer 
Plus immediately. After storing a few seconds of the clip (buffering), the playback begins.

· Click Open File or Open Location on the File menu on RealPlayer Plus. For more information, refer to 
File Menu.
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Pausing a Clip

You can pause a clip while it is playing by clicking the  button. This halts the stream. If you want to 
resume the clip at the same point it was paused, click the 

 button again.
If you pause a clip but do not resume playing after several minutes, the server may terminate your connection. 
The length of time you can pause a clip without your connection terminating depends on the particular server.
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Stopping a Clip

You can stop a clip while it is playing by clicking the  button. The clip stops playing. To play the clip 
again from the beginning, click the 

 button.
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Muting a Clip

You can mute a clip while it is playing by clicking the     button. The clip continues to play but does not 
play the audio.
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Recording a Clip
The Selective Record function allows you to record files from the Internet. To copy local files, use the file copy 
command in your Operating System.

To start recording a RealMedia clip during playback:

1. Click the  button. A Save As dialog box appears. 
2. Select the filename and location on your computer where you want to save the file. 
3. Click the OK button when you have finished entering the information. RealPlayer Plus begins recording. 

While RealPlayer Plus is recording, the  icon appears in the Status Bar of RealPlayer Plus.
Some RealMedia clips are really several files played one after another. If you chose to save a RealMedia clip that
is a compilation of several clips, a new Save As dialog box appears at the beginning of each new clip.

For best recording quality, select PerfectPlay Mode, and do not pause the clip while recording.
Note: Content providers control whether or not you may record a clip. If you attempt to record a clip that has 
this feature disabled, the  icon appears in the Status Bar of RealPlayer Plus.

To start recording a RealMedia clip prior to playback: 

1. Click the  button. 
2. Open the clip. A Save As dialog box appears. 
3. Select the filename and location on your computer where you want to save the file. 
4. Click the OK button when you have finished entering the information. RealPlayer Plus begins recording and

playing the selected clip. While RealPlayer Plus is recording, the  icon appears in the Status Bar of 
RealPlayer Plus.

Some RealMedia clips are several files played one after another. If you chose to save a RealMedia clip that is a 
compilation of several clips, a new Save As dialog box appears at the beginning of each new clip.

For best recording quality, select PerfectPlay Mode, and do not pause the clip while recording.
Note: Content providers control whether or not you may record a clip. If you attempt to record a clip that has 
this feature disabled, the  icon appears in the Status Bar of RealPlayer Plus.

To stop recording:

Click the  button. RealPlayer Plus stops recording, but the RealMedia clip continues to play. If you want 
to continue listening to the clip without recording, click the 

 button; the clip begins playing from the beginning.
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Changing the Size of the RealPlayer Plus Window
Do one of the following:

· From the View menu, select the appropriate option to modify the size of the RealPlayer Plus window. 

· Normal displays all the controls and buttons.
· Compact displays a select group of buttons: 

· Auto-Size looks like Compact when the cursor is over the window and only displays an 
image window (if playing a non audio-only clip) when the cursor is not over the window.

· Click the button to display the RealPlayer Plus in Compact view. This view displays a subset of 
buttons, a smaller status bar and the image window (if playing a non audio-only clip).
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 Changing the Size of the Image Area
You can increase the size of a video clip image to either double size or to full screen size (Windows 95 or NT 
only). However, this increases the processing time required for playback. If your playback quality decreases or if
your machine seems overloaded, you should return the picture to normal size.

To increase the image area:

1. Click the  button.
For Windows 95 or NT users, you will see a pop-up menu with zoom options. Otherwise the image area 

simply doubles.
2. Select the 2X or the Full Screen option from the menu (Windows 95 or NT only).

Note: When you choose the Full Screen option, sometimes the image is surrounded by a black border. This is 
normal for clips that have odd height-to-width ratios.

To return to normal size from Full Screen (Windows 95 or NT only):

· Click the anywhere on the screen.

To return to normal size from 2x size (Windows 95 or NT only):

1. Click the  button.
2. Select the Normal option.
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Playing Clips in PerfectPlay Mode
PerfectPlay mode enables you to improve the sound quality by increasing the amount of the clip that is 
streamed to RealPlayer Plus before the clip begins playing. The time it takes to buffer the clip will be slightly 
longer, but playback quality, especially with 14.4 and 28.8 Kbps modems, should be improved. To return to 
Regular mode, select this option again.

Note: You cannot use PerfectPlay mode with a live stream.

To enable PerfectPlay mode:
· Select PerfectPlay Mode from the File menu. 

Note: Content providers determine whether PerfectPlay mode is available for a specific clip. 
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Selecting a Preset Button
To select a Preset button:

· Click the appropriate Preset button. RealPlayer Plus connects to the corresponding site and begins 
playing the clip.

To view other rows of Preset buttons:
· Click the up or down arrow next to the rows of presets to cycle through the preset rows.
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Setting a Preset Button
Preset Buttons allow you to quickly jump to a RealMedia Internet address, much like the buttons on a radio jump
to preset stations.

To set a Preset Button to the clip currently being played:

1. In the RealPlayer window, right-click the Preset Button you want to set to the current clip and select Set 
Preset to (current clip).

2. Type in a Preset Label for the Preset Button and click OK.

To set a Preset Button manually:

1. Choose the Preferences option from the View menu.

2. Choose the Presets tab.

3. Type in the full URL (Internet address) of the site for the Preset Button.

4. You can also enter text for the Label of the Preset Button.
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Setting Your Destination Buttons
Your RealPlayer Plus comes with six buttons that you can customize to access premium content with a push of a 
button.

To customize the Destination buttons:
· Click one of the buttons. RealPlayer Plus opens your default browser to the Customize Destinations page 

(http://www.real.com/destinations) where you can select specific content that you like. The buttons on 
your Player will then provide access to that content. Follow the directions on that page.

To play Destination buttons content:
· Click the appropriate button. RealPlayer Plus plays the associated file. 

See Also:

Starting a Clip 
Pausing a Clip 
Stopping a Clip 
Muting a Clip 
Recording a Clip 
Changing the Size of the RealPlayer Plus Window 
Changing the Size of the Image Area 
Playing Clips in PerfectPlay Mode 
Selecting a Preset Button 
Scanning Clips 



Scanning Stations
The Scan feature allows you to sample RealMedia stations, similar to scanning stations on a radio. It plays each 
station for the amount of time specified on the Presets tab of the Preferences window and then continues on to 
the next station.

To begin scanning stations:
· To play all available stations: click the Scan button. RealPlayer Plus scans and plays the next station. It 

plays the station for the amount of time specified on the Presets tab of the Preferences window and then 
continues on to the next station.

· To select a category of stations: right-click the Scan button. A pop-up menu appears, where you can 
select the category (for example: news, music, sports, international) or you can select to scan your Preset
buttons. RealPlayer Plus scans for the next station that matches the category you selected.

To stop scanning and view and listen to current station:
· Click the Scan button again.

To set a Preset Button to the station currently being played:
· Right-click on the Preset Button you want to set to the current station and select Set Preset.

To return to a previous station:
· Select Previous Clip from the Clip menu or press PAGE UP.

To skip to the next station:
· Select Next Clip from the Clip menu or press PAGE DOWN.

To stop scanning and stop listening to the current station:

· Click the  button.
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Setting Preferences
You can customize RealPlayer Plus by changing the settings in the Preferences window. These settings control 
various aspects of RealPlayer Plus applications functionality, such as the number of clips to remember, network 
information, and proxy information. These preferences apply to all applications using RealPlayer technology.

See Also:
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Proxy Preferences 

Advanced Preferences 
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General Preferences
The General tab in the Preferences window contains preferences for the number of clips saved on the Open 
Recent menu, Synchronized Multimedia support, and PerfectPlay. 

Field Description
Recent Clips You can quickly replay clips by clicking Open Recent on 

the File Menu. This setting controls how many clips are 
displayed in the Open Recent menu.

Synchronized Multimedia Some RealMedia clips contain synchronized multimedia 
events that display pages or images in your web 
browser. This setting controls whether RealPlayer 
applications enable these events.

PerfectPlay/ BufferedPlay RealPlayer Plus allows playback of higher quality clips on
lower bandwidth connections with the PerfectPlay 
feature. This setting controls how much of the clip is 
buffered before beginning playback.

Connection Preferences
The Connection tab in the Preferences window contains information about your bandwidth, statistics, and server
timeout.

Field Description
Bandwidth RealPlayer Plus automatically selects which content can 

be delivered in real time over your connection. This 
setting controls the bandwidth of the content selected.

Statistics RealPlayer Plus maintains statistics on connection 
quality. These statistics help content providers improve 
the quality of their service. This setting controls whether 
statistics are sent to the content provider.

Note: RealPlayer Plus does not send the content 
provider any information about your identity (your user 
name or e-mail address).

Network Timeout These settings determine how long RealPlayer Plus will 
either try a particular transport protocol, or will try to 
connect to a server.

Transport Preferences
The Transport tab in the Preferences window allows you to customize your network connection for RealPlayer 
Plus. Most likely, if you are connecting to the Internet through a commercial ISP, you do not have to set any of 
the items on this tab.

The description of these preferences assumes a basic knowledge of Internet protocols and firewalls. For more 
information about firewalls, refer to our World Wide Web site at:

http://www.real.com/help/firewall

Field Description
Network Transport RealMedia clips can be transmitted to your computer 

via several different network transports. This setting 



controls how these network transports are selected.

Automatically select most 
efficient transport

Use this setting if you are not aware of any problems 
that require you to specify a transport method.

Click the Auto Configure button to have RealPlayer 
Plus automatically configure itself to use the most 
efficient mode of transport for your connection.

Use specified transports Use this setting if your computer has problems using 
some network transports. (Consult your network 
administrator for the appropriate setting.)

Click the Specify Transport button to access the 
Specify Transports window. Refer to Specify Transports 
Window.

UDP Port Some networks have limited ports available for Internet
applications. This setting controls which port RealPlayer
applications use for receiving data. (Consult your 
network administrator for the appropriate setting.)

Note: This setting does not affect TCP packets, which 
can only be received through Port 7070.

Specify Transports Window
The Specify Transports window allows you to select the different modes of network transports that you can 
receive. (Consult your network administrator for the appropriate setting.)

Field Description
Use TCP to Connect to 
Server

Select this option if you want RealPlayer Plus to use TCP
for the initial connection to RealServer.

Attempt to use Multicast 
for live content

Select this option if you want RealPlayer Plus to 
attempt to receive live content through Multicast. 

If you select this option, indicate how many 
milliseconds the Player should attempt to use this type 
of transport before switching to UDP.

Attempt to use UDP for 
static content and for live 
content not available via 
Multicast

Select this option if you want RealPlayer Plus to 
attempt to use UDP for static content and live content 
not available via Multicast.

If you select this option, indicate how many 
milliseconds the Player should attempt to use this type 
of transport before switching to TCP.

Attempt to use TCP for all 
content

Select this option if you want RealPlayer Plus to use TCP
for all content.

Use HTTP Only Select this option if you are behind a firewall and 
cannot receive data through TCP. All data will be 
streamed through HTTP.

Note: You may not be able to receive some content if 
you select this option.



 Proxy Preferences
A proxy is a server that acts as an intermediary between a company's protected LAN (local area network) and 
the Internet. The proxy server insures that all data transmission between the Internet and a user on the LAN is 
authorized. RealPlayer Plus can be configured to work with proxy servers by setting the proxy preferences.

For more information about proxies and firewalls, read: http://www.real.com/help/firewall

Field Description
Use Proxy Click this box if RealPlayer Plus should connect to the 

Server using a proxy; a check mark appears in the field. 
Otherwise, do not click this box.

Note: If you are behind a firewall and do not know the 
host name or port number of your proxy server, ask 
your firewall administrator.

RealPlayer Proxy Enter the domain name or IP address of the RealPlayer 
Plus proxy server and port number that RealPlayer Plus 
should use to communicate with the proxy server. 

Note: For information on, read:
http://www.real.com/help/firewall

HTTP Proxy Enter the domain name or IP address of the HTTP proxy 
server and port number that RealPlayer Plus should use 
to communicate with the proxy server. Check your 
World Wide Web browser's proxy configuration.

No Proxy for: [Host 1, 
Host2¼]

If you have specified that RealPlayer Plus should be 
connected to the Server using a proxy, you can specify 
certain local hosts (domain names or IP Addresses) with 
which you do not need to communicate using the proxy 
server. Enter these hosts in this field. This field is only 
available if you have enabled the Use Proxy option.

Your system administrator can provide you with this 
information, if appropriate.

Advanced Preferences
Options on the Advanced tab of the Preferences window override RealPlayer Plus defaults for sound card 
compatibility. You don't need to use these options unless you are having troubles with sound quality.

Field Description
Playback Performance RealPlayer Plus uses this setting to optimize the 

performance of clip playback. Change this setting only if 
your computer seems sluggish or has problems while 
playing some audio content.

Sound Card Compatibility Modify sound card settings to overcome audio problems.

Disable 16-bit sound (use
8-bit only)

Use this setting if you have an older sound card and clips
sound scratchy or distorted.

Disable custom sampling
rates 

Use this setting if clips play at the wrong speed or sound 
scratchy or distorted. (Requires a floating point 
coprocessor.)

System Tray Select this option if you want RealPlayer Plus to remain 
resident on your system, creating an icon in your system



tray. With this option selected, you will be able to quickly
access RealPlayer Plus.

Language Preferences
The setting on the Language tab of the Preferences window determines the language used within the RealPlayer
applications.

Field Description
Current Language This field displays the language being used within 

RealPlayer Plus.

Installed Languages Select the language you want to use within RealPlayer 
Plus.

Note: Please contact RealNetworks regarding 
information on languages available for RealPlayer 
applications.

Upgrade Preferences
Using the Upgrade tab of the Preferences window, you can customize how often the application queries the 
RealNetworks home page to check for available upgrades. 

Field Description
Upgrade Notification RealPlayer Plus periodically contacts the RealNetworks 

web site to determine if a newer version is available. 
When a newer version is available, RealPlayer Plus alerts
you and provides a link to a web site where you can 
download the new version.

If you do not want RealPlayer Plus to check for upgrades,
check the Disable Automatic Upgrade Notification 
button.

Check for Upgrade 
Availability

Click this button to check for any available RealPlayer 
Plus upgrades.



Presets Preferences
Using the Presets tab of the Preferences window, you can modify the label of a Preset and the URL 
corresponding to that Preset button. You can also set the length of time each clip is played while scanning clips.

Field Description
Row Number Select the row of preset buttons that you want to 

change.

Preset Specifies the button number in the selected row.

Label Enter the text string you want to appear as the label of 
this Preset button. 

URL Enter the URL (Internet address) you want to play when 
this Preset button is clicked. You must enter the full URL. 
For example: 
http://presets.realaudio.com/plus/pop1.ram

Scan Time This setting controls how long RealPlayer Plus plays each
clip while it scans.

Troubleshooting
For the latest information on RealMedia products, visit the RealNetworks home page at:

http://www.real.com

A technical knowledge base, frequently asked questions list and technical library are available from our web site
at:

http://service.real.com

Please refer to your Technical Support Card for more information on contacting RealNetworks Technical Support.

See Also:

How do I configure my browser to support Media?  

How do I get Full Screen to work?  

What's wrong when the playback quality is poor?  

Why doesn't my RealPlayer Plus have a Volume Control slider?  

Why can't I play RealAudio or RealVideo clips on my computer at work?  



How do I configure my browser to support RealMedia?
With most browsers, RealPlayer Plus installation configures the browser to support RealMedia playback. If you 
change your browser and it stops recognizing RealMedia files, reinstall RealPlayer Plus. To manually configure 
your World Wide Web browser, do the following:

1. Open the Options, Preferences or Settings menu. 

2. Select the Helper Applications or a similar option. 

3. Look for "audio/x-pn-realaudio" in the File type list. If that entry exists, select that entry. 

Otherwise, click New Type. Enter audio as the Mime Type. Enter x-pn-realaudio as the Mime SubType. 
Click OK. 

4. Enter rm, ra, ram in the Extensions field. 

5. Select the Launch Application option. Browse and find the directory in which RealPlayer Plus is installed. 
(By default, the RealPlayer Plus is installed in c:\Real\PlayPlus\)

6. Select RealPlayer (realplay.exe) as the application to launch.



 How do I get Full Screen to work?
The Full Screen option is available for Windows 95 and Windows NT users only. If you are using one of these 
operating systems and still have problems with Full Screen (e.g. only a black screen appears), make sure that 
you have the following installed on your machine:

· Microsoft Direct-X Tools with Direct Draw

You can download the most recent version and installation instructions from Microsoft's web site 
(http://www.microsoft.com). When you install Direct-X, you must choose to upgrade your video drivers. You 
may lose old functionality of your drivers, however.

· Updated video drivers

You can find these either from the company that manufactured you video card or from RealNetworks' Direct
Draw support page (http://www.real.com/products/player/fullscreen.html). If you update your video drivers, 
you may lose old functionality of your drivers.



What's wrong when the playback is poor?
The expected playback quality varies depending on bandwidth and the encoding algorithm you are playing. If 
the quality is garbled, choppy, or skips, use the following to isolate and correct the problem. 

If the quality was poor when the Thankyou.rm file played at the end of the RealPlayer Plus installation, you 
have a sound card conflict. Try changing the settings on the Advanced tab in the Preferences window. Refer to 
Advanced Preferences.

If the quality was good when the Thankyou.rm file played at the end of the RealPlayer Plus installation, but is 
bad at a particular site, use the Connection Statistics window in RealPlayer Plus to check for lost packets. If the 
packet loss is high, it may be due to a busy network. Select PerfectPlay Mode from the File menu or connect 
to the site at a later time. 

If the quality was good when the Thankyou.rm file played at the end of the RealPlayer Plus installation, but 
sounds bad at all sites, complete the following steps.

If the playback quality is poor on every site, do the following: 

1. Check the actual modem connection speed. This may be shown in the lighted display for external 
modems, or through an information window if you have an internal modem (check the user manual for 
your modem). Sometimes service providers use a lower rate connection speed such as 14.4 Kbps, so 
even though you are dialing in on a 28.8 Kbps modem, you are only receiving data at 14.4 Kbps. 

2. If you are using an external modem with a Windows PC and the Connections Statistics window shows 
minimal packet loss (10% or less), there may be a problem with the speed at which packets are 
transferred between the modem and serial card. Try setting the port speed higher (at least twice the 
modem speed).

3. Contact RealNetworks' Technical Support.



Why doesn't my RealPlayer Plus have a Volume Control slider?
Be sure a check mark appears next to the Info & Volume option on the View menu. If the check mark does not 
appear, click the Info & Volume option.

If the sound card installed in your computer does not support volume control, the Volume Control slider does not
appear on RealPlayer Plus.



Why can't I play clips on my computer at work? 
If you're on a local area network which is attached to the Internet, and are unable to play RealMedia files from 
remote Web sites, it's possible that your company's firewall is preventing the stream from reaching you. Users 
can receive live and on-demand audio and video from the Internet without exposing their company's network to 
security risks.

If your computer is behind a firewall, please see RealNetworks' firewall page for more information: 
http://www.real.com/help/firewall




